
CHAPTER 1

Introduction to ILWIS 3.0

ILWIS is an acronym for the Integrated Land and Water Information System. It
is a Geographic Information System (GIS) with Image Processing capabilities. ILWIS
has been developed by the International Institute for Aerospace Survey and Earth
Sciences (ITC), Enschede, The Netherlands.

As a GIS and Remote Sensing package, ILWIS allows you to input, manage, analyze
and present geo-graphical data. From the data you can generate information on the
spatial and temporal patterns and processes on the earth surface.

Geographic Information Systems are nowadays indispensable in many different fields
of applications to assist in the decision making process. Most decisions are
influenced by some facts of geography. What is at a certain location? Where are the
most suitable sites? Where, when and which changes took place? Here are some
examples. 

- In land use planning, GIS is used to evaluate the consequences of different
scenarios in the development of a region. 

- In geology, GIS is used to find the most suitable places for mining, or to determine
areas subject to natural hazards. 

- Areas that may be affected by pollution are analyzed using GIS functions.

- Extensions of cities are planned, based on analysis of many spatial and temporal
patterns, etc.

In order to be able to make the right decisions, access to different sorts of
information is required. The data should be maintained and updated and should be
used in the analysis to obtain useful information. In this process ILWIS can be an
important tool.

This chapter is intended to introduce you to ILWIS, and specifically to the user
interface. You will learn how to start ILWIS, the functions of the Main window and
how to open maps and tables.
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1.1  Starting ILWIS
To start ILWIS, double-click the ILWIS icon on the desktop. After the opening screen
you see the ILWIS Main window (see Figure 1.1). From this window you can manage
your data and start all operations.

The ILWIS Main window consists (by default) of a Title bar, a Menu bar, a Standard
toolbar, an Object selection toolbar, a Command line, a Catalog, a Status bar and an
Operations/Navigator pane with an Operation-tree, an Operation-list and a Navigator.

There is a possibility that the right-central part (i.e. the Catalog) of the Main window
on your screen does not look exactly the same as shown in Figure 1.1. This may be
due to the fact that you have another system configuration and/or that during the
installation of ILWIS you decided to copy the data files to a different directory than
the standard start-up directory C:\ILWIS 3.0 Data\.

1.1.1  The Navigator

Before continuing with the exercises you first need to change to the subdirectory
C:\ILWIS 3.0 Data\Users Guide\Chapter01, where the data files for this chapter
are stored.
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Figure 1.1: The ILWIS Main window.



You can use the Navigator (Figure 1.2) to change the current drive and working
directory. 

The Navigator lists all drives and directories (i.e. folders) in a tree structure. The
Navigator also has a History to easily return to previously visited drives and
directories. 

1.1.2  Catalog(s)

If you are in the correct directory C:\ILWIS 3.0 Data\Users Guide\Chapter01 you
will see, that the right hand side of the Main window, looks exactly the same as
Figure 1.3. This part of the Main window, in which maps, tables and other ILWIS
objects in the working directory are displayed each with its own type of icon, is
called the Catalog. When you double-click an object in the Catalog, it will be
displayed.
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Figure 1.2: The ILWIS Navigator.

• Click the word Navigator in the Operations/Navigator pane.☞

• Click on the drives and folders in the Navigator until you are in the directo-
ry where the data for this chapter has been stored. By default the data is
located in C:\ILWIS 3.0 Data\Users Guide\Chapter01.

☞



The following objects, related to the area surrounding the city of Cochabamba in
Bolivia, can be seen:

Cochabamba
A coordinate system, containing the definition of the coordinate system (the
minimum and maximum coordinates of the study area and optionally the map
projection) used for the maps of the Cochabamba area;

Landuse
A domain, listing names of the mapping units in the Landuse map and the Landuse
table;

Landuse
A polygon map containing land use units in the study area (the city of Cochabamba
and surroundings in Bolivia);

Landuse
A representation, containing the color assignments of the mapping units in the
Landuse map;

Landuse
An attribute table containing information on the land use units;

View3D1
A domain, explaining the content of the raster map View3D1;

View3D1
A raster map, containing a three dimensional picture of the study area;

View3D1
A representation, containing the color assignments of the pixels in raster map 

View3D2

View3D2

View3D2

A domain, raster map and representation of another 3D picture View3D2.
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Figure 1.3: Example of a Catalog of the ILWIS Main window.



! For a complete list of ILWIS objects and their icons, see the summary of section
1.1 or the ILWIS Help topic Basic concepts, ILWIS objects and icons.

Customizing the Catalog

To show only maps and tables in the Catalog:

The object Selection tab contains a list box in which the object types that are shown
in the Catalog appear highlighted. You see that all ILWIS objects are selected. To
show only the map and table objects, i.e. the objects with the icons , , ,

and :

You will see that the Catalog has changed and that now only the map and table
objects are shown in the current Catalog. The ILWIS Main window may show more
than one Catalog. You can thus keep your data organized in different directories. 

! You can open another Catalog by clicking the New Catalog button in the
Standard toolbar and selecting a new directory. You can also select the New
Catalog command on the Window menu of the Main window.

1.1.3  Title bar and Menu bar

The Title bar (Figure 1.4) shows the name of the currently active Catalog. You can
move a window to another position on the screen by dragging that window’s Title bar
to another position.
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• Click the Customize Catalog button in the Standard toolbar (Figures
1.1 and 1.8) of the Main window. The Customize Catalog sheet is opened.

☞

• On the object Selection tab, select the first object type (i.e. the Raster
Map), keep the left mouse button pressed and move the mouse pointer to the
last object you want to select (i.e. the Table).

• Release the mouse button and click OK.

☞

• Position the mouse pointer on an object, for example on polygon map
Landuse. A description of this map will appear on the Status bar (Figure
1.7) of the Main window.

☞

Figure 1.4: Title bar of the ILWIS Main window.



The Menu bar (Figure 1.5) can be used for example to start an operation. The ILWIS
Main window has six menus: File, Edit, Operations, View, Window and Help.

1.1.4  The Operation-tree and Operation-list
Let us now concentrate on the another part of the ILWIS Main window. The
Operation-tree and the Operation-list (Figure 1.6) are located on the first two tabs in
the Operations/Navigator pane, by default along the left-hand side of the Main
window. 
- The Operation-tree provides a tree structure for all ILWIS operations, similar to

the Operations menu. 
- The Operation-list contains an alphabetic list of all ILWIS operations.

In the Operation-tree as well as in the Operation-list each item is preceded by an
icon. The icon indicates the output data type of the operation. By double-clicking an
operation, the operation will be started. We will do this later.
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Figure 1.5: The Menu bar of the Main window.

• Click Operations in the Menu bar. The Operations menu is opened. The
menu contains commands for all ILWIS operations, which are grouped. The
triangles to the right of the commands on a menu indicate that there is
another cascading menu.

• Position the mouse pointer on the command Image Processing. A submenu
appears.

• Select the Filter command. The Filtering dialog box is opened. In this dialog
box you can select among other things the input maps for an operation.

• Close the dialog box by clicking the Cancel button.

• Open some more menus and have a look at their contents. The Status bar
(at the bottom of the Main window) gives short explanations.

☞

Figure 1.6: ILWIS Operation-tree (left) and ILWIS Operation-list (right).



1.1.5  Status bar
When the mouse pointer is positioned on an operation, the Status bar (Figure 1.7),
located at the bottom of the Main window, shows a short description of that
operation. 

To get more information on an operation: 

The Status bar also gives short information when you move the mouse pointer over
a menu command, over a button in the Toolbar or over an object in the Catalog.

A Context-sensitive menu is a menu, which gives only those menu commands that
are applicable to the moment you use the right mouse button; thus you will get a
different menu depending on where and when you use the right-mouse button. For
example, if you use the right mouse button on a polygon map, the context-sensitive
menu will only show the operations which can be applied on polygon maps. Context-
sensitive menus are shortcuts for normal menu commands.

1.1.6  Toolbars of the Main window

You will go back to the Main window to see three more items. Below the menu, you
find two toolbars:
- The Standard toolbar
- The Object selection toolbar

Introduction to ILWIS 3.0
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• In the Operation-tree, double-click Image Processing, or click on the + in
front of the Image Processing icon , to expand the Image Processing
tree.

• Position the mouse pointer on one of the operations, for example on the
Filter operation.

☞

• In the Operation-list, click with the right mouse button on an operation and
select Help from the context-sensitive menu. An Additional Help window
appears with a short explanation of the operation.

• You can close the Additional Help window again by pressing the Close but-
ton in the Title bar of the Help window or by double-clicking the con-
trol-menu icon .

☞

Figure 1.7: The Status bar of the ILWIS Main window.

• In the Catalog, click with the right mouse button on polygon map Landuse
to get a context-sensitive menu.

☞



The Standard toolbar

The Standard toolbar (Figure 1.8) provides shortcuts for some regularly used menu
commands.

The Standard toolbar has the following buttons:

New Catalog Properties

Open Map Customize Catalog

Open Pixel Information List

Copy Details

Paste cd..

Delete

When you leave the mouse pointer for a short period of time on top of a button a
ToolTip will appear with the name of the button/menu command that it will perform.
Also the Status bar gives some information on the working of the button. So far,
you have used the Customize Catalog button . 

Other buttons that you will probably use frequently are:

List. Show the objects in the current Catalog as a list of icons and object names.

Details. Show the details of the objects in the current Catalog in a table-like form.

This will be explained in more detail in chapter 2.

The Object selection toolbar

The Object selection toolbar (Figure 1.9) allows you to specify the object types that
you wish to see in the current Catalog.

Only the object types of which the button appears down will be shown. For a list of
all ILWIS object types and icons, see the summary of section 1.1. The first button,
the ILWIS button , is used to hide all objects (after which you can click specific
object buttons, to show only these object types), or to show all object types. To add
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Figure 1.8: Standard toolbar of the ILWIS Main window.

Figure 1.9: The Object selection toolbar.



coordinate system Cochabamba to the Catalog:

To hide the coordinate system again:

1.1.7  The Command line

The last item we will discuss now is the Command line (Figure 1.10). 

For beginners, the Command line is not so important yet. You can use the
Command line to type MapCalc formulas when you want to calculate with raster
maps (chapter 7) but also operations (like Filter, etc.) can be performed by typing an
expression on the Command line (see chapter 12). 

The Command line has a History. You can use: 
- the Arrow Up key of your keyboard to retrieve previously used expressions and

commands;
- the Arrow Down key to scroll forwards again, and
- the Arrow Down button at the right hand side of the Command line to open a

list of previously used commands and expressions. 

1.1.8  Getting help

The ILWIS Help allows you to obtain information from any point within the
program. The Help menu differs per window. In the Main window the Help menu
has many options; we will explain a few of them now:
- Help on this Window. You obtain help on the current window. Depending on the

window from which you select this help option, you can get help on the Main
window, the map window, the table window, the pixel information window, etc.

- Related Topics. When this menu option is selected a dialog box appears with a
list of topics that are related to the current window.

- Contents. Displays the Help Contents. By clicking the links in the table of
contents you can go to any help topic you like.
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• Press the Coordinate Systems button in the Object selection toolbar.
Coordinate system Cochabamba is now added to the Catalog.

☞

• Click the Coordinate Systems button again.☞

Figure 1.10: The ILWIS Command line.

• Open the Help menu.☞



- Index. The Index page of the ILWIS Help is displayed. Type a keyword or click
any keyword in the list on which you wish to get help.

- Search. The ILWIS Help viewer is opened with the Search tab selected. Type
some characters, a word, or a phrase on which you want to obtain help and press
Enter ↵ or click the List Topics button to get a list of topics. In the Select topic
list box select the topic you want to display and click the Display button or press
Enter ↵ . 

- Basic Concepts. Gives an overview of the basic concepts of ILWIS. These
concepts will be treated in chapter 2 of the User’s Guide.

The ILWIS HTML Help viewer (Figure 1.11) has three parts: 
- a Topic pane that shows the topic the user has selected;
- a Navigation pane with 4 tabs: a Contents tab, an Index tab, a full-text Search

tab, and a Favorite tab;
- a Toolbar which allows users to Show or Hide the Navigation pane, to move

Forward to the next topic or Back to the previous topic, to go to the
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• From the Help menu, select the command Help on this Window. The
ILWIS Help viewer (Figure 1.11) is opened and the help topic Main
Window, Contents is shown.

• Click the hyperlink Introduction. The ILWIS Help viewer refreshes and dis-
plays the topic Main window: Introduction, in which all parts of the Main
window are explained.

• Click any of the links. Another topic appears explaining you more.

☞

Figure 1.11: The ILWIS HTML Help viewer.



Home/Contents Page topic, and to adapt the Font size, to Print topics and to
change the Options.

To find a Help topic, click one of the following tabs in the help window: 
- To browse through topics by category, click the Contents tab.
- To see a list of index entries, click the Index tab and then either type a word or

scroll through the list.
- To search for words or phrases that may be contained in a help topic, click the

Search tab. In the left of the Help window, click the topic, index entry, or phrase to
display the corresponding topic in the Topic pane.

Summary: the Main window of ILWIS

When you start ILWIS, the first thing you will see after the opening screen is the
ILWIS Main window. From this window you can manage your data, start all
operations and select all data. The Main window contains the following items:

- A Catalog lists the available maps, tables and other ILWIS objects in the current
working directory. When you double-click an object, the object will be opened.
When you click an object with the right mouse button, you can choose to start an
application with the selected object as input. The ILWIS Main window can show
one or more Catalog(s).

- The ILWIS object types and their icons that can be shown in a Catalog are: 

raster maps georeferences

polygon maps coordinates systems

segment maps histograms of raster maps

point maps histograms of polygon maps

tables histograms of segment maps

map lists histograms of point maps

object collections sample sets

map views two-dimensional tables

layouts matrices

annotation text objects (user-defined) filters

domains user-defined functions

representations scripts

Introduction to ILWIS 3.0
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• Use the browse buttons Back and Forward to go page by page through the
Help.

• Practice a bit more with the ILWIS Help. When you have finished, close the
Help window by double-clicking the Control-menu icon in the Title
bar of the Help viewer.

☞



- The Operation-tree provides a tree structure for all ILWIS operations, similar to the
Operations menu.

- The Operation-list contains an alphabetic list of all ILWIS operations. Each opera-
tion is preceded by an icon; the icon indicates the output data type of the operation. 

- The Navigator provides a tree structure for all drives and directories and has a his-
tory of recently visited drives and directories. 

- The Title bar is always located at the top of the window. It shows the name of the
window and can be used to move the window on the screen.

- The Menu bar can be used to start an operation, to create or edit objects, to view
the properties of an object, etc. 

- The Standard toolbar provides shortcuts for regularly used menu commands such
as Customize Catalog, List/Details View, etc. 

- The Object selection toolbar can be used to select the object types that should be
visible in the currently active Catalog. 

- The Command line is mainly used to type calculations (MapCalc) and expressions
(i.e. perform operations).

- The Status bar gives short information on the item on which the mouse pointer is
located: a menu command, a button in the Toolbar, an object in the Catalog, an
operation in the Operation-list or the Operation-tree, etc. 

- The ILWIS Help allows you to obtain help information from any point within the
program. The ILWIS Help viewer has a Topic pane, a Navigation pane and a
Toolbar.

ILWIS 3.0 User’s Guide

Introduction to ILWIS 3.0

12



1.2  Displaying geographic data
Geographic data are organized in a geographic database. This database can be
considered as a collection of spatially referenced data that acts as a model of reality.
There are two important components of geographic data (Figure 1.12): the
geographic position and the attributes, entities or properties. In other words, spatial
data (where is it?) and attribute data (what is it?) are distinguished. In the example of
Figure 1.12, you can see that we have a (very simplified) map on one side and a table
on the other. 

Maps are considered spatial data, since the information they contain is directly
related to certain locations on the earth’s surface. The location of the units A, F and G
are specified with respect to their X and Y coordinates. 

Tables, on the other hand, do not contain direct information on a location. They
contain descriptive information (in this case the names of the land use types and the
value of the land in monetary units). If we would only have the table, the data would
not be useful, since we don’t know where the units are located. If we would only have
the map, we still don’t know anything about the units. In a Geographic Information
System (GIS) like ILWIS, the link between spatial and attribute data is the key to get
real information. Only by combining spatial and attribute data we can get answers to
questions such as: Where are the land use units with a value more than 250?

In the following pages we will show you how to display spatial data and attribute data
in ILWIS. We will introduce you to the map window and you will practice displaying
a map. The map to be displayed is the polygon map Landuse that shows the
different land use types in the Cochabamba area in Bolivia. This map was digitized
from a paper map. A polygon map is a vector data object containing closed areas
including the boundaries making up the areas, which in this case represent land use
units. In chapter 2 there will be a more detailed explanation about polygon maps.

Introduction to ILWIS 3.0
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Figure 1.12: Spatial and non-spatial data in ILWIS.



ILWIS dialog boxes

A dialog box allows the user to enter the information required by ILWIS to carry out
an operation. Dialog boxes differ depending on the application you are performing.
The dialog box, which is displayed now, is used to specify how you want to display a
polygon map. In general, an ILWIS dialog box can have features such as:

Title bar. Shows the name of the dialog box and can be used to move the dialog box
on the screen. In this case the title is: Display Options - Polygon Map.

Text box. A small box, which can be used for typing text or values. The dialog box
shown on your screen contains a Text box in which you can specify the Boundary
Width of the land use units lines.

Drop-down list box. A small box with an Arrow Down button , which allows
you to select items. A list, including the available data, will be displayed when the
arrow button or list box is clicked. The button on the right hand side is the create
button. The Create button can be used to create an object when the list excludes a
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• Press the polygon map button in the Object selection toolbar to show
the polygon maps again and double-click the polygon map Landuse in the
Catalog. The Display Options - Polygon Map dialog box appears (see
Figure 1.13).

☞

Figure 1.13: Example of a Display Options - Polygon Map dialog box.



proper object. When you click the Create button, the program proceeds to a new
dialog box. 

The dialog box in Figure 1.13 contains two list boxes: one in which you can specify
the color of the boundary lines of the land use units (Boundary Color), and another
(Representation) in which you can indicate the color of the units themselves. These
colors are stored in an object called representation (see section 2.4).

Check box. This is a small square in the dialog box, which allows you to select or
clear an option. The Display Options – Polygon Map dialog box has five check
boxes. When you select the Info check box, you will be able to read information
about the meaning of the land use units, once the map is displayed. The second box
Scale Limits allows you to define the scale limits of the map. The third check box
Mask allows you to selectively display some land use types. If the fourth box,
Boundaries Only is selected, only the boundaries of the land use units will be
shown. Finally, the fifth box, Attribute, can be selected if you want to display an
attribute value from a table connected to the map, instead of the land use units
themselves.

Command buttons are used to initiate an action. The OK, Cancel, and Help are
common command buttons.

OK button: whenever you click the OK button (or press Enter ↵ on the keyboard) the
dialog box is closed and the action will be executed.

Cancel button: when you click the Cancel button (or press Esc on the keyboard) the
dialog box is closed and the action is canceled. 

Help button: when you click the Help button (or press F1 on the keyboard) context-
sensitive help information will be displayed. Context-sensitive help means help
dealing with the specific dialog box.

Option buttons. Option buttons can be seen as circles and represent a group of
mutually exclusive options. The selected option button contains a black dot. You can
select one option at a time. Selecting another Option button, clears the other. As you
can see, ILWIS gives suggestions for options in the dialog box, which are called the
defaults.

! To select a check box or an Option button click the check box or press the
Spacebar. If the name of the option or check box has an underlined letter, you
can select the Option button or check box by pressing and holding down the Alt-
key while typing the underlined letter.

Introduction to ILWIS 3.0
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• Select the check box Boundaries Only. Now you will see that the contents
of the whole dialog box changes. If you only want to show the boundary
lines of the units, no input is needed anymore on how you want to 

☞

➥



! You can move through the various options within a dialog box by using the Tab-
key or the Shift+Tab-keys on the keyboard.

A map window

The polygon map Landuse is displayed in a map window (see Figure 1.14). All
maps in ILWIS are displayed in a map window. The map window has many similar
features as the Main window of ILWIS, which we have seen before. It consists by
default of a:

Title bar: located at the top of the map window. The Title bar shows the name of the
window and can be used to move the map window.

Menu bar: located just below the Title bar. A map window has 5 menus: File, Edit,
Layers, Options and Help.

Toolbar: located just below the Menu bar. The Toolbar provides shortcuts for some
regularly used Menu commands. The Toolbar of the map window has the following
buttons: 

Entire Map Zoom Out

Redraw Normal

Measure Distance Add Layer

Pan Remove Layer

Zoom In Save View

Scale box: Text box in which you can type the scale on which the map(s) should be
displayed.

Layer Management pane: The left central part of the map window displays the
layers (maps) that are added to the map window and the legend of each map. In the
Layer Management pane, you can for instance change the order of the layers that
are displayed. The Layer Management pane will be extensively treated in the next
chapter.

Map viewer: The right central part of the map window where the maps are displayed.
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display the units themselves. The contents of the dialog box depends on the
input of the user. That is why we call it context-sensitive.

• Select the drop-down list box Boundary Color. You will see a list with all
different types of colors that you can select.

• Practice some more with the different options in the dialog box. After that,
change all options again so that they are the same as in Figure 1.13. Then
confirm your input by clicking the OK button or by pressing Enter ↵ . 

➦



Status bar: located at the bottom of the window. The Status bar displays
coordinates in meters and/or geographic coordinates.

The map window can be moved, like all windows, by activating it and dragging it to
another position. The size of the map window can be changed in several ways.

Introduction to ILWIS 3.0
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Control menu icon Menu bar
Toolbar

Title bar

Scale box
Minimize button

Maximize button
Close button

Layer Management pane Status barScroll bar Map viewer

Figure 1.14: An ILWIS Map window.

• Move with the mouse pointer to a border or to a corner of the map window.
The mouse pointer changes into a two-headed arrow.

• Drag (press the left mouse button and hold it down) the border or corner
until the window has the size you want and release the left mouse button. The
map window has been resized.

• Maximize the map window by clicking the Maximize button in the upper
right corner of the window.

☞



When you want to study details of the map, the zooming possibility can be used.

Another way to zoom in or out is by re-scaling the map.

Next, we will pay attention to another part of the map window: the Status bar,
which can be found at the bottom of the map window. If you move with the mouse
pointer over the map, you will see that the Status bar displays the position of the
mouse pointer in the map. To specify the position in an absolute way a coordinate
system is used. There are many different coordinate systems in use around the world. 

Coordinates can be displayed in two ways:
- as metric coordinates (X,Y), or as
- geographic coordinates (latitude, longitude).

The Status bar displays the coordinates in meters and/or geographic coordinates.
First, the X, Y values of metric coordinates are given; these are followed by the
degrees, minutes and seconds of the latitude and longitude (i.e. geographic
coordinates).
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• Click the Zoom In button in the Toolbar to zoom in on a selected area.

• Move the cursor (now in the shape of a magnifying glass) to the first corner
of the area that has to be displayed in detail and click on the left mouse but-
ton. Keep the mouse button down and drag the cursor a little bit to the sec-
ond corner of the area of interest; then release the mouse button. Now the
selected area will appear enlarged. You can also click in the map window to
zoom in.

• To roam through the map on which you zoomed in, use the Pan button 
or use the Left/Right/Up/Down scroll boxes in the horizontal or the vertical
scroll bar.

• A fast scroll can also be achieved by dragging the scroll boxes in the scroll
bars Left/Right or Up/Down, or by clicking in the scroll bar itself.

• Select the Zoom Out button in the Toolbar and click (repeatedly) in the
map to zoom out.

• Click the Entire Map button to show the entire map in the map window
again.

☞

• Activate the Scale box which is by default located next to the Toolbar of
the map window and type another scale factor for the map (e.g. 1:200000)
and press Enter ↵ .

☞



With the Measure Distance button it is easy to measure the distances and the
angle between two points.

The Distance message box will state:
From: the XY-coordinate of the point where you started measuring;
To: the XY-coordinate of the point where you ended measuring;
Distance on map: the distance in meters between starting point and end point
calculated in a plane;
Azimuth on map: the angle in degrees between starting point and end point related
to the grid north;
Ellipsoidal Distance: the distance between starting point and end point
calculated over the ellipsoid;
Ellipsoidal Azimuth: the angle in degrees between starting point and end point
related to the true North, i.e. direction related to the meridians (as visible in the
graticule) of your projection;
Scale Factor: direct indicator of scale distortion, i.e. the ratio between distance on
the map/true distance.
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• Click the Normal button in the Toolbar to go back to the normal view.

• Move the mouse pointer through the map and verify in the Status bar that
the X values increase when going to the right of the map (towards the east),
and the Y coordinates increase when going to the top of the map (towards the
north).

• Try to locate the mouse pointer on the following X and Y coordinates:
X=803384, and Y=8074877, and find the corresponding latitude and longi-
tude.

☞

• Click the Measure Distance button in the Toolbar of the map window,
or choose the Measure Distance command from the Options menu.

• Locate the mouse pointer somewhere in the map, and press the left mouse
button. Move to another point, while keeping the left mouse button pressed.
When you release the mouse button a message box appears. 

☞

• Click OK in the Distance box and click the Normal button in the Toolbar
to go back to the normal view.

☞



The contents of the map: domain

You can obtain information on the map contents simply by pressing the left mouse
button on any of the colored units in the map.

Domain As you can see, the units of the Landuse map are described by classes, with names
such as Forest, Grassland, Bare rock, Lake, etc. The list of all class names
that can occur in a map is called in ILWIS a domain. A domain defines the possible
contents of a map, a table, or a column. In other words, what do the items in a map,
table or column mean? Are they classes (such as land use classes), or values or
something else? The domain concept is very essential in ILWIS, and we will
therefore come back to it in chapter 2. The full list of class names of the land use
units can be seen in the Layer Management pane of the map window when the map
is displayed, but you can also open the domain of the polygon map Landuse
yourself. 

The Domain Class editor is opened. The Title bar reads: Domain Class
“Landuse” - ILWIS. As you can see, the domain lists all possible class names of the
map. It is simply a list of all land use types, which can occur in the map. Since these
are different classes, we speak of a class domain. In chapter 2 you will also see some
other domain types.

We started this lesson by explaining the difference between spatial and non-spatial (or
attribute) data. From the map window, we can also obtain information on attributes,
related to the different land use units of the map, which is displayed.
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• Press the left mouse button on different units in the map to find out what
they represent.

• Find the land use class around the location: X=801830 and Y=8089283.

☞

• Make the ILWIS Main window active. If the Main window is visible on the
screen, then you can just click any part of the Main window. If the Main win-
dow is not visible anymore, click the ILWIS button on the Windows
Taskbar at the bottom of your screen.

• Make all the objects visible by clicking the ILWIS button in the Object
selection toolbar. 

• Double-click the domain Landuse in the Catalog of the Main window.

☞

• Close the Domain Class editor by clicking the Control-menu icon and
select Close.

☞



Now you will see a small window appearing with the title Attributes. Inside the
window you will see two lines. The first line contains the land use class name of the
unit you clicked, and the second line contains the word Landvalue followed by a
number, which is the average monetary value of this land use type. The line with
Landvalue information is a line from an attribute table Landuse, which is linked
to the map.

Let us look now in more detail to tables, but first close the map window.

A table window

Table We will finish this chapter by showing you how to display attribute data.

The table Landuse is now displayed in a table window (Figure 1.15). As you can see
from Figure 1.15, a table window contains many of the features we have already seen
in the Main window and in the map window. It has a Title bar, a Menu bar with the
menu options: File, Edit, Columns, Records, Graphs, View and Help and a
Toolbar with the buttons: 

Copy New Graph Window

Paste Goto First Record

Delete Goto Previous Record

Print Goto Record

Properties Goto Next Record

Update all columns Goto Last Record
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• In the map window, double-click with the left mouse button a unit in the
polygon map Landuse.

☞

• In the Catalog, double-click the table Landuse.☞

• Close the map window by opening the File menu in the map window and
choose Exit, or click the Close button in the map window.

☞



Furthermore, there is a Command line, a Table viewer, a Split bar with the
Statistics Pane below it and a Status bar.

The table contains two columns. The left column, in gray color, has no header. If you
look closely to the names in this left column you will remember that those are the
names that you have seen also in the map Landuse. This is again the domain; a
domain can thus define the contents of a map, but also the contents of a table.

Next to the left gray column containing the domain items, the table has one more
column, called Landvalue. This column is an attribute column that contains the
average value of the land in fictive monetary values. As you can see, this column
contains values.
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Control menu icon

Title bar

Record view button

Toolbar

Command line

Minimize button
Maximize button

Close button

Statistics pane Scroll barTable viewerStatus bar
Split bar

Column properties 
button

Figure 1.15: An ILWIS table window.

• Double-click the Column header with the name Landvalue on it. The
Column Properties dialog box (Figure 1.16) appears. 

☞



This dialog box contains information on column Landvalue. The dialog box shows
for instance the domain of column Landvalue: Default Value Domain. The next
line gives the Value Range of column Landvalue: between 0 and 10000. The
actual values in the column are also shown: Minimum: 50, Maximum: 1000.

Information on the Minimum (Min) and Maximum (Max) values in the column,
together with the Average (Avg), Standard Deviation (StD) and Sum of the
column, is visible in the Statistics Pane in the lower part of table Landvalue.

You will now practice with the various items related to the display of tables. First we
will show you how to switch between Table View (in which you will see the table
ordered in such a way that the information of one record is displayed in different
columns) and Record View (in which you will see only the information related to
one record):
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Figure 1.16: Example of a Column Properties dialog box.

• Click the Cancel button to close the Column Properties dialog box.☞

• In the table window, click a Record button, for example the Record button
Grassland (the left gray button with the name Grassland on it). A small
Record View window appears. It shows the current record 

☞

➥



By default, data in a table are sorted on the domain of the table. The records of a
table can also be sorted on one of the columns in the table. 

By clicking the Column option in the dialog box, you can select the column which
you wish to sort. The record order of the table will change as well.

In chapter 5 many more options of the table window are treated. For now, close the
table.

Summary: displaying maps and tables

In this section you have learned:

- How to use dialog boxes: How to enter parameters to define the way in which a
map is displayed.

- The basics of a map window: How to open a map; the different components of a
map window: Title bar, Menu bar, Toolbar, Map viewer, Layer Management
Pane, Status bar; to resize a map window; to zoom in and to zoom out; to read
the coordinates of a map (coordinate system); to know the contents of a map
(domain).

ILWIS 3.0 User’s Guide

Introduction to ILWIS 3.0

24

(Grassland) and the attribute value(s) we have for this unit (in this case
only the Landvalue). 

• In the Toolbar of table Landuse, click the Goto Next Record button 
or the Goto Last Record button to go to the next or to the last
record respectively.

• Click the Goto Previous Record button or the Goto First Record but-
ton to go to the previous record or to the first record respectively.

• Click the Goto Record button to go to a specific record in the table. 

➦

• Open the Columns menu and select the Sort command. The Sort dialog box
is opened.

☞

• In the Sort dialog box, select the Column option, and then select column
Landvalue from the drop-down list box. Accept the Sort Order
Ascending and click OK. Now the table is ordered ascendingly according
to the values in the column Landvalue.

• Resort the table using the Record sequence Domain.

☞

• From the File menu, select Exit or double-click the Control-menu icon
of the table window.

☞



- The basics of a table window: How to open a table; the different components of a
table window: Title bar, Menu bar, Toolbar, Command line, Table viewer, Split
bar, Statistics Pane, Status bar; the fact that contents of a table are defined by
the domain of the table; the fact that columns also have a domain. The display of an
entire table (i.e. Table View), or only the contents of a certain record (i.e. Record
View); to sort a table.
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1.3  The Cochabamba area
Before we will have a more detailed look at the main concepts of ILWIS in the next
chapter, it is maybe good to introduce you to the study area from which most of the
data for the ILWIS User’s Guide are taken: the Cochabamba area. 

The picture which is displayed is a three dimensional view of the Cochabamba area.
This picture was made by the Display 3D operation which will be treated in chapter
10, using a Digital Elevation Model (DEM) and a False Color Composite (FCC)
derived from Landsat TM bands.

Cochabamba city is a fast growing center with a population of approximately
300,000. The city is located in the Andean region of Bolivia, at an elevation of about
2600 meters above sea level. It is located in a large valley, bordered on the northern
side by steep mountains, rising up to an elevation of 4500 meters. The northern part
of the city is located on the alluvial fans at the foot of the mountains. Due to the
high-intensity rainfall in the period November-January, the mountain area is subjected
to landslides and soil erosion, and the city itself occasionally suffers from flashfloods
on the alluvial fans. These processes affect the local farmers, and also hinder the
expansion of the city. 

A more detailed 3D view of the city of Cochabamba itself, made from a scanned
aerial photograph, is also available. 
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• In the Catalog, double-click raster map View3D1. The Display Options –
Raster Map dialog box is opened. 

• Click OK.

☞

• Zoom in on the right-hand side of the picture (Cochabamba city). ☞

• Close the map View3D1, and open raster map . Have a look at it, and close it
when you have finished. 

☞


